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Limited Warranty 

All products manufactured and sold by Digital Control Incorporated (DCI) are subject to the terms of a 
Limited Warranty. A copy of the Limited Warranty is included at the end of this manual; it can also be 
obtained by contacting DCI Customer Service, 425-251-0559 or 800-288-3610, or at DCI's website, 
www.digitrak.com. 

Important Notice 

All statements, technical information, and recommendations related to the products of DCI are based on 
information believed to be reliable, but the accuracy or completeness thereof is not warranted. Before 
utilizing any DCI product, the user should determine the suitability of the product for its intended use. All 
statements herein refer to DCI products as delivered by DCI and do not apply to any user customizations 
not authorized by DCI nor to any third-party products. Nothing herein shall constitute any warranty by DCI 
nor will anything herein be deemed to modify the terms of DCI’s existing Limited Warranty applicable to all 
DCI products. The most recent version of this manual is available on DCI's website. 

Compliance Statement 

This equipment complies with Part 15 of the Rules of the FCC and with Industry Canada license-exempt 
RSS standards and with Australia Class License 2000 for LIPD (low interference potential devices). 
Operation is subject to the following two conditions: (1) this equipment may not cause harmful 
interference, and (2) this equipment must accept any interference received, including interference that 
may cause undesired operation. DCI is responsible for FCC compliance in the United States: Digital 
Control Incorporated, 19625 62nd Ave S, Suite B103, Kent WA 98032; phone 425-251-0559 or 800-288-
3610. 

Changes or modifications to any DCI equipment not expressly approved and carried out by DCI will void 
the user’s Limited Warranty and the FCC’s authorization to operate the equipment. 

CE Requirements 

  DigiTrak receivers are classified as Class 2 radio equipment per the R&TTE Directive and 
may not be legal to operate or require a user license to operate in some countries. The list of restrictions 
and the required declarations of conformity are available on DCI’s website, www.digitrak.com, under the 
Service & Support tab. Click on DOWNLOADS and select from the CE Documents pull-down menu to 
download, view, or print the documents. 

http://www.digitrak.com/
http://www.digitrak.com/customerservice/downloads.html
http://www.digitrak.com/customerservice/downloads.html
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Contact Us 

United States 

DCI Headquarters 

19625 62nd Ave S, Suite B103 

Kent, Washington 98032, USA 

+1.425.251.0559 / 1.800.288.3610 

+1.425.251.0702 fax 

dci@digital-control.com 

Australia 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 fax 

dci.australia@digital-control.com 

China 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, P.R.C. 

+86.21.6432.5186 

+86.21.6432.5187 fax 

dci.china@digital-control.com 

Europe Brueckenstraße 2 

97828 Marktheidenfeld 

Germany 

+49.9391.810.6100 

+49.9391.810.6109 fax 

dci.europe@digital-control.com 

India DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 fax 

dci.india@digital-control.com 

Russia Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Russia 121467 

+7.499.281.8177 

+7.499.281.8166 fax 

dci.russia@digital-control.com 

mailto:dci@digital-control.com
mailto:dci.australia@digital-control.com
mailto:dci.china@digital-control.com
mailto:dci.europe@digital-control.com
mailto:dci.india@digital-control.com
mailto:dci.russia@digital-control.com
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Dear Customer, 

Thank you for choosing a DigiTrak locating system. We are extremely proud of the equipment we 
have been designing and building in Washington State since 1990. We believe in providing a 
unique, high-quality product and standing behind it with superior customer service and training. 

Please take the time to read this entire manual, especially the section on safety. Also, please fill 
in the product registration card provided with this equipment and either mail it to DCI 
headquarters, fax it to us at 253-395-2800, or complete and submit the form online at our 
website, www.digitrak.com. We will put you on the Digital Control mailing list and send you 
product upgrade information and our FasTrak newsletter. 

Feel free to contact us if you have any problems or questions. Our Customer Service department 
is available 24 hours a day, 7 days a week. International contact information is available on our 
website. 

As the horizontal directional drilling industry grows, we’re keeping our eye on the future to 
develop equipment that will make your job faster and easier. Visit us online any time to see what 
we’re up to. 

We welcome your questions, comments, and ideas. 

Digital Control Incorporated 
Kent, Washington 
2013 

 

See our DigiTrak Training Videos on YouTube at www.youtube.com/dcikent. 

http://www.digitrak.com/
http://www.youtube.com/dcikent
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Safety Precautions and Warnings 

Carefully review this manual and be sure you always operate your DigiTrak locating system properly to 
obtain accurate depth, pitch, roll, and locate points. If you have any questions about the operation of the 
system, please contact DCI Customer Service for assistance. 

General 

 

Warning All operators must read and understand the following safety 
precautions and warnings and must review this operator’s manual 
before using a DigiTrak Locating System. 

  

 

Serious injury and death can result if underground drilling equipment makes 
contact with an underground utility such as a high-voltage electrical cable or a 
natural gas line. 

 

Substantial property damage and liability can result if underground drilling 
equipment makes contact with an underground utility such as a telephone, cable 
TV, fiber-optic, water, or sewer line. 

 

Work slowdowns and cost overruns can occur if drilling operators do not use the 
drilling or locating equipment correctly to obtain proper performance. 

 

DCI equipment is not explosion-proof and should never be used near flammable 
or explosive substances. 

 

In the event of electrostatic shock, the display screen may go blank. No data loss 
will occur. Click the trigger to reset the receiver, or toggle down to reset the 
remote display. 

 

Hot surfaces can occur on cable transmitters if housing requirements are not met. 
Always ensure the transmitter is installed properly in the housing during use. 

 

Directional drilling operators MUST at all times: 

 Understand the safe and proper operation of drilling and locating equipment, including the use of 
ground mats and proper grounding procedures. 

 Ensure that all underground utilities have been located, exposed, and accurately marked prior to 
drilling. 

 Wear protective safety clothing such as dielectric boots, gloves, hard hats, high-visibility vests, and 
safety glasses. 

 Locate and track the transmitter in the drill head accurately and correctly during drilling. 

 Maintain a minimum distance of 8 in. (20 cm) from the front of the receiver to the user’s torso to 
ensure compliance with FCC requirements. 
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 Comply with federal, state, and local governmental regulations (such as OSHA). 

 Follow all other safety procedures. 

DigiTrak locating systems cannot be used to locate utilities. 

Continued exposure of the transmitter to heat due to frictional heating of the drill head can cause 
inaccurate information to be displayed and may permanently damage the transmitter.  

Remove the batteries from all system components during shipping and prolonged storage; damage 
caused by leakage may occur. 

Equipment and Battery Disposal 

 

This symbol on equipment indicates that the equipment must not be disposed of with your 
other household waste. Instead, it is your responsibility to dispose of such equipment at a 
designated collection point for the recycling of batteries or electrical and electronic 
equipment. If the equipment contains a banned substance, the label will show the pollutant 
(Cd = Cadmium; Hg = Mercury; Pb = Lead) near this symbol. Before recycling, ensure 
batteries are discharged or the terminals are covered with adhesive tape to prevent 
shorting. The separate collection and recycling of your waste equipment at the time of 
disposal will help conserve natural resources and ensure it is recycled in a manner that 
protects human health and the environment. For more information about where you can 
drop off your waste equipment for recycling, please contact your local city office, your 
household waste disposal service, or the shop where you purchased the equipment. 

The battery charger provided with your DigiTrak locating system is designed with adequate safeguards to 
protect you from shock and other hazards when used as specified within this document. If you use the 
battery charger in a manner not specified by this document, the protection provided may be impaired. Do 
not attempt to disassemble the battery charger, it contains no user-serviceable parts. The battery charger 
shall not be installed into caravans, recreational vehicles, or similar vehicles. 

Pre-Drilling Testing 

Before each drilling run, test your DigiTrak locating system with the transmitter inside the drill head to 
confirm it is operating properly and providing accurate drill head location and heading information. 

During drilling, the depth will not be accurate unless: 

 The receiver has been properly calibrated and the calibration has been checked for accuracy so the 
receiver shows the correct depth. 

 The transmitter has been located correctly and accurately and the receiver is directly above the 
transmitter in the drill head underground or at the front locate point. 

 The receiver is placed on the ground or held at the correct height-above-ground distance, which has 
been set correctly. 

Always test calibration after you have stopped drilling for any length of time. 
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Interference 

Interference can cause inaccuracies in the measurement of depth and loss of the transmitter’s pitch, roll, 
or heading. Always perform a background n up to 6561 ft. (2000 m).oise check prior to drilling. 

 Sources of interference include, but are not limited to, traffic signal loops, invisible dog fences, cable 
TV, power lines, fiber-trace lines, metal structures, cathodic protection, telephone lines, cell phones, 
transmission towers, conductive earth, salt, salt water, rebar, and radio frequencies. 

 Interference at the remote display may also occur from other sources operating nearby on the same 
frequency, such as car rental agencies using their remote check-in modules or other directional 
drilling locating equipment. 

 Background noise must be minimal and signal strength must be at least 150 points above the 
background noise during all locating operations. 

 Because this equipment may generate, use, and radiate radio frequency energy, there is no 
guarantee that interference will not occur at a particular location. If this equipment does interfere with 
radio or television reception, which can be determined by powering the equipment off and on, try to 
correct the interference using one or more of the following measures: 

o Reorient or relocate the receiving antenna. 

o Increase the separation between the receiver and affected equipment. 

o Consult the dealer, DCI, or an experienced radio/TV technician for help. 

o Connect the DCI equipment to an outlet on a different circuit. 
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Introduction 

 

DigiTrak F5 SST Guidance System 

The DigiTrak F5 SST Guidance System is designed for horizontal directional drilling (HDD) projects 
where walkover locating is difficult. It provides real-time tool information that enables accurate steering of 
the drill head directly from the remote display and computer interface. The SST (Short Steering Tool) 
transmitter is a wireline device that has an internal compass to determine heading or direction. A 
magnetic shield is provided for protection from magnetic fields when the transmitter is not in use, and a 
special non-magnetic housing is required during drilling. 

Steering data is shown in real time on both the remote display at the drill rig and on the laptop computer, 
which can be placed up to 50 ft (15 m) away from the remote. The remote and computer are connected 
through the cable box, which is also connected to the SST transmitter and the power source. The F5 
receiver is used for calibration and to confirm transmitter data. DCI recommends that you use a 
combination of walkover and non-walkover locating whenever possible to increase the capabilities and 
accuracy of the SST system. A standard F5 system can be upgraded to the F5 SST system. 

F5 SST transmitter 
Magnetic 

shield 

Laptop computer 
with LWD software 

F5 SST 
receiver 

SST remote  
display 

Cable box  
(MFCB) 
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There are some important terms and procedures that are used specifically with the SST system that you 
should understand. These include the following: 

 Heading – Azimuth compass heading or direction measured by the SST transmitter with respect 
to the Earth’s North Pole. (Known as Yaw in the Eclipse steering tool system.)  

 Reference heading – Azimuth heading of the SST transmitter measured when it is accurately 
positioned on the surveyed bore path prior to the start of the drill run. The course deviation is 
determined from this heading. The value for the reference heading is determined at the start of 
the SST operating procedure. (Known as reference yaw or Ref Yaw in the Eclipse steering tool 
system.) 

 Shoot the probe – Term commonly used for the procedure of measuring the reference heading 
using the SST transmitter (probe).  

 360° roll – Standard HDD walkover systems use a “clock” roll orientation. The SST transmitter 
uses a 360° roll sensor with 1° increments, where 0° = 12 o’clock, 90° = 3 o’clock, 180° = 
6 o’clock, and 270° = 9 o’clock. 

The following types of data are displayed and recorded with the SST guidance system: 

 Heading (in tenths of a degree) – Displayed on receiver and remote and recorded on computer.  

 Reference heading (in tenths of a degree) – Displayed on remote and recorded on computer. 

 Heading deviation (in tenths of a degree) – Amount of deviation SST transmitter is exhibiting from 
the reference heading; displayed on remote and recorded on computer. 

 Depth (in feet or meters), pitch (in tenths of a percent or tenths of a degree), and roll (in degrees 
from 0–360°) – Displayed on receiver and remote when receiver is used for walkover locating; 
calculated depth is displayed and recorded on computer. 

 Course deviation (in feet/meters) – Displayed and recorded on computer. 

 Temperature (in degrees Fahrenheit or Celsius) – Displayed on receiver and remote; not 
recorded on computer. 

 Voltage levels for power supply and SST transmitter (in volts) – Displayed on remote; not 
recorded on computer.  

 System current (in amps) – Displayed on remote; not recorded on computer.  

 Distance from drill rig and bore distance (in feet/meters) – Displayed and recorded on computer 
only. 

 Date and time of recording – Displayed and recorded on computer only. 

To further expedite wireline connection time, the SST system can be used with the DigiTrak CableLink 
connection system. The CableLink system is preinstalled in drill rods so that the electrical connection is 
made when the rods are threaded up. 

This operator’s manual begins by describing the primary System Components—including the SST 
transmitter, the F5 SST receiver, the SST remote display, the multi-function cable box (MFCB), and the 
laptop computer with preinstalled LWD (Log-While-Drilling) software—and the other supplies needed for  



 Introduction 

DigiTrak
®
 F5

®
 SST

®
 Operator’s Manual 11 

using the SST system. The next section presents the System Operating Instructions, which cover the 
standard procedure for setting up and using the SST guidance system. This is followed by instructions for 
using the LWD computer software in general (LWD Software Instructions), and then by detailed 
information on Inputting and Editing Drill Data in the computer. System specifications and maintenance 
requirements are provided in Appendix A, and specific instructions for repair of the wireline components 
in the SST transmitter are given in Appendix B.  

Some terms and techniques used in this manual are considered basic to the F5 locating system. If you 
have never used the F5 system, then you are required to read the operator’s manual for the system 
(DigiTrak F5 Directional Drilling Locating System Operator’s Manual) before using the SST system. 

NOTE: You must know how to operate the F5 locating system prior to operating the F5 
SST guidance system. 

You also must read the instructions given in this SST system operator’s manual and familiarize yourself 
with the various menu screens on your F5 SST receiver and remote display before using the system for a 
production drill. We also recommend that you review the LWD software application and the help files in 
the software relating to the SST (steering tool) guidance system. If you have questions, please call DCI 
Customer Service. 
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System Components 

The F5 SST guidance system consists of the following main components, which are described in this 
section:  

 SST transmitter – A cable transmitter with an internal compass; requires protective magnetic 
shield.  

 F5 SST receiver – An F5 receiver upgraded with the SST capability. 

 SST remote display – A multi-function remote display (DigiTrak FSD or MFD) with SST capability.  

 Multi-function cable box (MFCB) – An interface unit that connects all hard-wired system com-
ponents, including the SST transmitter, remote display, computer, and power source. 

 Laptop computer with LWD software – A dedicated computer with LWD software preinstalled and 
ready to use. 

In addition, some equipment, tooling, and specialty items are required for use with the SST system but 
are not provided by DCI. These items are identified and described at the end of this section. 

SST Transmitter with Magnetic Shield 

The SST transmitter is similar to the standard cable transmitter except that it also provides heading 
information and requires special non-magnetic shielding and a non-magnetic housing. The heading 
information, in addition to the pitch and roll data, enables the drill operator to determine the SST 
transmitter’s position and orientation, and thus allows steering of the tool.  

The SST transmitter provides heading and pitch updates every 1.3 seconds and roll updates more than 3 
times per second. The SST transmitter has a repairable end cap assembly; two spare assemblies are 
provided with the transmitter so that the cable lead and end cap components can be replaced or rebuilt as 
needed (see Appendix B).  

Because the SST transmitter is a magnetic-sensitive device, it needs to be kept away from all magnetic 
sources. A protective magnetic shield, which is essentially a copper sleeve, is provided with the SST 
transmitter. The magnetic shield should be placed on the end of the SST transmitter at all times when the 
transmitter is not in use.   

 

SST Transmitter and Protective Magnetic Shield  

 

White wire  
to cable box 

Magnetic shield 

SST transmitter 
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NOTE: The SST transmitter must be kept at least 5 ft (1.5 m) away from all magnets including the 
remote display, which has a magnetic mount that will damage the transmitter. A special non-
magnetic housing is required. 

The non-magnetic housing for the SST transmitter must be a rear-load housing. To prevent overheating 
and for optimum performance, the transmitter must be installed correctly in the housing. An extraction/-
insertion tool is provided with the SST transmitter for use in properly installing it into and removing it from 
the housing. Installation instructions are provided in the System Operating Instructions section. 

It is critical that the slots in the drill housing meet minimum length and width requirements and be 
correctly positioned. DCI recommends at least three slots equally spaced around the circumference of the 
housing. Each slot must be at least 1/16 or 0.0625 in. (1.6 mm) wide. For accuracy, slot measurements 
must be taken from the inside of the housing. The SST transmitter, which is 24 in. (60.96 cm) long, 
requires slots in the housing that are at least 9 in. (22.9 cm) long and begin at least 8.5 in. (21.6 cm) from 
the front end of the transmitter, as shown below. 

 

SST Transmitter Housing Slot Requirements 

F5 SST Receiver  

The F5 SST receiver is an F5 receiver that has been upgraded with the SST capability. The receiver is 
used to locate the SST transmitter when walkover locating is possible and to confirm depth readings and 
other transmitter data. The locating procedure for the SST is the same as that for the standard F5 locating 
system, with simple two-button (trigger and toggle switch) operation.  

         

F5 SST Receiver Side View (left) and Top View (right) 

Display 
screen 

Trigger 
switch 

Toggle switch 

Slot position 

8.5 in. 
(21.6 cm) 

Slot length 
9 in. (22.9 cm) 

Front end  Wireline end 
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Any F5 receiver can be upgraded to have the SST capability. The SST upgrade adds the SST option, as 
defined below, to the cable transmitter menu.  

 

SST transmitter option – Enables detection of an SST transmitter when the SST receiver 
is in locate mode. This transmitter option must be selected to calibrate and track the SST 
transmitter using the receiver. When an SST transmitter is selected, the SST heading 
information appears on the locate mode screen and the roll indicator on the receiver 
display shows units in degrees (from 0° to 360°) rather than the standard clock positions.   

 

SST Remote Display 

The SST remote display is a multi-function remote that receives and displays real-time information 
including heading, pitch, roll, temperature, and battery status. Any DigiTrak F Series Display (FSD) or 
DigiTrak Multi-Function Display (MFD) can be upgraded to have the SST capability.  

An SST remote operates much like a standard remote display, with the function buttons on the keypad 
(direction buttons and execute button) and the main menus operating in the same manner. The SST 
remote menu options include the standard options plus an option to set the reference heading. This menu 
option is discussed further in the System Operating Instructions section.  

 

SST Remote Display  

An SST remote operating in cable mode with an SST transmitter will show roll units in degrees (from 0° to 
360°), whereas a standard remote display operating with other transmitters shows roll units that cor-
respond to the numbers on a clock (1 through 12).  

Display 

screen 

Direction 

buttons 

Execute 

button 

Magnetic 
base 
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Multi-Function Cable Box (MFCB) 

The cable box routes power to the SST transmitter and the remote display and sends transmitter data to 
the remote and the computer laptop. It is installed between the DC power port on the back of the remote 
display and a DC power source.  

          

Cable Box with Power Supply and Remote Display Cables 

A special power cable is provided for use with a panel-mounted MFD 
remote. This cable plugs into the back of the MFD and the other end 
connects to the cable box.  

The white wire from the SST transmitter connects to the power post on 
the cable box. The laptop computer is connected to the serial port on 
the cable box. When connected, real-time data can be viewed at the 
computer, and data points can be logged by the computer operator. The 
SST software allows for viewing, logging, editing, graphing, saving, and 
printing of the drill data. See the LWD Software Instructions section for 
more information. 

Complete information and procedures for setting up the SST system 
and connecting the system components is given in the System Oper-
ating Instructions section.  

 

 

Cable to  
power supply 

Cable to  
remote display  

Power post for  
SST wireline Serial port for 

computer connection 

 

Cable for Panel-Mounted 
MFD Remote 
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Laptop Computer with LWD Software 

The F5 SST system comes with a dedicated laptop computer (PC) that has the LWD (Log-While-Drilling) 
software preinstalled. A 50-ft (15-m) long serial cable is provided for connecting the computer to the serial 
port on the cable box. A USB flash drive that contains the LWD software, this operator’s manual, and 
sample data is also provided with the system.  

The LWD software is used with other LWD applications; however, only the information that is pertinent to 
running the SST guidance system is included in this manual. Instructions for the other LWD applications 
are given in the DigiTrak LWD DataLog System Operator’s Manual. 

The steering application in the LWD software is used with the SST system. A typical steering job screen 
as it appears in the LWD application window is shown below. See the LWD Software Instructions and the 
Inputting and Editing Drill Data sections in this manual for more information about the software and how 

to use it. 

 

LWD Steering Tool Application Window  

NOTE: Loading additional programs on the dedicated SST laptop could cause problems with 
the functioning of the LWD software. 
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Non-DCI Components That Are Needed  

Some equipment, tooling, and specialty items required for operation of the SST system are not supplied 
by DCI. These include the following:  

 Non-magnetic housing for SST transmitter – Must be rear-loading with slots milled per the 
housing slot requirements discussed earlier in this section. 

 Monel (non-magnetic drill rod) – A monel approximately 15-ft (4.6-m) long for use between the 
non-magnetic housing and the first drill rod; a second monel may be required if you are using a 
mud motor. 

 Fish tape or device to fish wire through rod 
 10-gauge wire – Approximately 20 ft (6 m) for use as a ground connection when establishing the 

reference heading. 
 10-gauge wire – Enough for bore length and additional for pullback of rods. 
 Butt splices for 10/12 gauge wire 
 Heat shrinks 
 Crimper 
 Heat gun 
 Transit or theodolite 
 String for string line 
 Tape measure 
 12–28V DC battery or power supply 
 Amp meter 
 Digital level 
 Compression fitting – Required to seal the transmitter from drilling fluid; contact a drill or tooling 

manufacturer for information. 
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System Operating Instructions 

The SST guidance system provides information at the remote display and the computer that enables you 
to make accurate, reliable steering decisions. It also allows you to log and save the drill data.  

This section provides detailed operating instructions for using the system. Please read the procedure 
carefully and ensure that you understand all the instructions before you use the system. Also, before you 
start to set up the system, be sure you have all the non-DCI components that you will need, as specified 
in the System Components section under “Non-DCI Components That Are Needed.”  

The basic operating procedure includes the following general steps, which are detailed in this section: 

 Setting Up SST Laptop  

 Setting Up Equipment and Site 

 Setting Reference Heading and Roll Offset  

 Calibrating SST Transmitter and Confirming Proper System Operation 

 Logging Drill Run 

A summary of the procedure is provided at the end of the section.  

 

Setting Up SST Laptop 

1.  Plot Topography, Drill Plan, and Planned Deviation 

Any topographic and/or planned bore information that you want in your SST job file can be input into the 
SST software before drilling or during the drilling/logging process. DCI recommends that you input this 
information before drilling unless you have a dedicated computer operator who can ensure correct and 
accurate input. Instructions for inputting data are provided in the Inputting and Editing Drill Data section. 

Setting Up Equipment and Site 

2.  Establish Bore Path Reference Line and Mark Bore Path 

We recommend that you use surveying equipment to establish the bore path. Once, established, mark 
the bore path with a string line based off of the survey markers. This reference line will help in aligning the 
drill and non-mag tooling assembly to the intended bore path.   

3.  Assemble and Torque-up Non-Magnetic Housing to Non-Mag Tool 

Using the drill rig or other hydraulic torquing wrenches, thread the non-mag housing to the non-mag tool 
and torque-up. 
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4.  Align Drill to Marked Bore Path 

With the transit positioned at least 10 ft (3 m) ahead of the drill, position the drill so that the transit sights 
onto the center point of the drive chuck and/or centerline of the boom. Anchor the drill, and then use the 
transit to confirm that the drill is still aligned to the marked bore path; if not, adjust for proper alignment.   

 

Aligning Drill to Marked Bore Path 

5.  Position & Align Non-mag  
    Tooling Assembly onto  
    Marked Bore Path  

With the transit still in position but rotated 180°, 
place the tooling assembly at least 30 ft (9 m) in 
front of the drill, onto the marked bore path so that it 
is pointing in the direction of drilling with the tool or 
bent sub oriented to 0° (12 o’clock), as shown in the 
photo on the right and the SST Job Site Setup 
diagram below. Sight the transit onto the string line 
(highlighted by yellow dashed line in photo) and 
carefully align the non-mag assembly to the marked 
bore path. 

Be sure there are no large metallic objects, in-
cluding the drill, within 30 ft (9 m) of the non-mag 
assembly.  

 

Aligning Non-Mag Tooling  
Assembly to Marked Bore Path  
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SST Job Site Setup 

6.  Stage SST Equipment and Power Source Adjacent to Tooling Assembly 

In preparation for powering up the F5 SST equipment, position the following items adjacent to the tooling 
assembly, along with the required cords, cables, and supplies for connecting the components: 

 F5 SST receiver and fully charged battery pack 
 SST transmitter 
 SST remote display (if using a panel-mounted MFD, remove it from the drill rig console; contact 

your dealer for assistance if necessary) 
 Multi-function cable box (MFCB) 
 Power source, such as a generator or 12–28V battery  
 Amp meter  

NOTE: Keep the remote display with its magnetic mounting bracket at least 5 ft (1.5 m) from 

the SST transmitter or damage to the SST transmitter could occur. 

At least 30 ft (9 m)  
from tool to drill 

About 10 ft (3 m)  
from transit  
to drill 

MINIMUM  
30 ft (9 m)  

NO METAL ZONE 

Surveyed  
bore path 
marked with  
string line 

Non-mag tooling 
assembly with 
bit oriented at 0°  

Transit 

Centerline of boom 

Centerpoint of drive chuck 

Drill 
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7.  Connect and Power Up F5 SST Equipment 

First, install the battery pack in the receiver, and then click the trigger to power it up. From the main menu, 
go to the transmitter selection menu and select the cable option, and then the SST transmitter option. 

Next, connect the remote display to the cable box and the cable box to the power source, as shown in the 
following diagram. Then connect the SST transmitter to the amp meter and to the power post on the cable 
box. You must ground the transmitter by connecting the negative terminal on the power source to the 
metal end cap on the SST transmitter. 

Press the execute button on the SST remote to power it up. From the main menu select the cable mode 
option and press the execute button to enter cable mode. 

Verify that you see data on the remote display and the receiver. If you do not, then recheck your 
connections and try again or call DCI Customer Service for assistance.   

 

Setup for SST Transmitter Power Up and Amp Reading  

F5 SST  
receiver 

Battery  
(12–28V) 

SST  
transmitter 

SST remote 
display 

Cable  
box 

At least  
30 ft (9 m)  
from SST 
transmitter  
to drill 

10-gauge 
white wire 

Amp  
meter 

Drill 

Ground 
wire White  

wire 

Black wire 
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8.  Measure SST Transmitter Current Draw  

Using an amp meter hooked up in series as shown in the figure above, measure the current draw of the 
SST transmitter—a good reading is approximately 0.2 to 0.5 amp. The current draw will increase as the 
distance you drill increases. A normal current draw, for example, at 1500 ft (457 m) is about 0.7 amp. The 
maximum current draw you should see is approximately 1 amp. 

9.  Install SST Transmitter into Aligned Non-mag Tooling Assembly  

To install the SST transmitter into the aligned non-mag housing (tooling assembly), first screw the 
threaded end of the extraction/insertion tool into one of the two threaded holes (1/4”-20 thread) in the 
wireline end of the transmitter. Then insert the front end of the transmitter into the back end of the 
housing and gently push it in using the extraction/insertion tool until you feel the index slot engage onto 
the housing key. When the transmitter is properly keyed, it will not rotate.  

NOTE: Always use the extraction/insertion tool to install or remove the cable transmitter. Do not 
ever try to remove the transmitter from the housing by pulling on the transmitter wire.  

Disconnect the amp meter, and reconnect the SST transmitter’s wire to the power post on the cable box. 
Be sure to ground the housing; this is commonly done by cutting a length of wire and touching one end to 
a negative battery terminal and the other end to the non-mag housing.   

Setting Reference Heading and Roll Offset 

10.  Set Reference Heading – Shoot the Probe 

Press the up button on the front of the remote display from the cable mode screen to open the reference 
heading popup menu. The current heading (Heading) of the SST transmitter will display in the “Set” 
option box in the popup menu; this is the value that will be used for the reference heading (Ref Heading). 
The receiver’s locate mode screen also displays the heading of the SST transmitter. 

 

SST Remote Popup Menu for Establishing Reference Heading 

Keypad option for 
manual input of 

reference heading  
Set option shows 
current SST 
transmitter heading  
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Write down this value (the current heading shown in the set option box) as your reference heading for 
future use. To accept this value, push the right arrow button to highlight the set option, and then push the 
execute button. If the reference heading is to be entered manually, use the keypad option to enter the 
desired value.  

With the reference heading and SST transmitter heading the same, the reference heading value at the 
top of the remote display screen should match the heading value at the bottom of the screen, as shown 
below. The reference heading and heading are also graphically displayed by a dashed vertical line with 
an arrowhead and a tool icon (a long rectangular box) representing the SST transmitter, respectively. 

 

SST Remote Steering Screen Showing New Reference Heading 

NOTE: If possible, take a heading reading at several locations along the bore path. This will 
allow you to determine an average reference heading to use over the bore path and 
possibly identify variations in the heading that could result in inaccurate readings.  

When the SST transmitter’s heading does not match the reference heading, the tool icon will be to the left 
or right of the dashed line, and a corresponding value will display above the tool icon to indicate the 
number of degrees that the SST transmitter is off from the reference heading, as shown below.  

 

SST Remote Steering Screen Showing Heading 4.7° to Left of Reference Heading 

Reference heading 
(dashed line) 

Offset of SST 
transmitter 

heading from 
reference heading  

Reference 

heading 

Tool icon 

Heading value  
(also displays  

on receiver) 

Reference  
heading value 

Output voltage and 
system current  
from cable box 

Input voltage range 
(approx.) supplied  
to SST transmitter 
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11.  Set Roll Offset on Remote (if needed)  

If the SST transmitter’s 0° roll position does not match the bit’s 0° roll position, then the roll offset function 
must be used to electronically compensate for the difference. The roll offset function must be set or 
enabled on both the remote display and the receiver. Before setting the roll offset, position the drill head 
in a 0° roll orientation. 

To set the roll offset on the remote display, push the right arrow button from the steering screen. A popup 
menu will display to set a new roll offset, with the option to set the displayed value or exit.  

 

SST Remote Popup Menu for Setting New Roll Offset  

Push the right arrow button to highlight the set option and press the execute button. The roll position and 
roll value on the remote will change to read 0°, and the roll offset value (194° in this example) will appear 
below the letters “RO” on the lower right of the roll indicator, as shown below.  

 

SST Remote Steering Screen Showing New Roll Offset Value 

Drill head  
roll position  SST transmitter 

roll position 

Roll offset  

value 

Exit  Set new roll offset 
to this value 

Drill head  
roll position  
and value  
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To stop the roll offset function or change the roll offset value, push the right arrow button when at the 
steering screen to open the popup menu shown below. Toggle right to highlight the stop or set option, 
and then press the execute button. 

 

SST Remote Popup Menu for Stopping or Changing Roll Offset 

If the stop option is selected, the roll offset function will be turned off and the value of the roll shown on 
the remote display will be that of the SST transmitter. If the set option is selected, the roll offset function 
will be enabled with the roll offset value shown. 

12.  Set Roll Offset on Receiver (if needed) 

If you have set the roll offset function on the remote, then you must next set and 
enable the function on the receiver. First, select the roll offset option from the settings 
menu on the receiver. The roll offset menu will display, as shown below.  

 

 

SST Receiver Roll Offset Menu 

Stop option 

Set option 

Disable roll offset  

Exit (returns to 
settings menu) 

 

Set and enable  
roll offset (shown 

highlighted) 

 

 

Roll Offset  
Option 
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Select the set and enable roll offset option, and the following screen will display. 

 

SST Receiver Enable Roll Offset Menu 

Click the trigger to set the roll offset to the value displayed. The display will return to the locate mode 
screen with the roll offset enabled as indicated by the roll value being 0.0 and the letters “RO” appearing 
to the lower left of the roll indicator. 

 

SST Receiver Locate Mode Screen Showing New Roll Offset 

To disable and stop the roll offset function, select the roll offset option from the settings menu, then toggle 
right to highlight the option to disable the roll offset and click the trigger. The roll offset function will be 
disabled and the value of the roll shown on the receiver will be that of the SST transmitter.  

 

SST transmitter’s 
uncompensated  

roll position 

Drill head  

roll position  
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Calibrating SST Transmitter and Confirming Proper System Operation 

13.  Calibrate SST Transmitter to Receiver 

In this step, you will use the receiver to conduct a 1-point calibration (10 ft or 3 m), and then you will verify 
accurate depth readings using a tape measure.   

First, ensure that there are no metal structures within 30 ft (9 m), such as steel pipe, chain-link fence, 
metal siding, construction equipment, or automobiles. Also make sure that the receiver is not positioned 
over rebar or underground utilities. Check signal strength by selecting the locate mode from the receiver’s 
main menu screen. Position the receiver 10 ft (3 m) to the side of the SST transmitter in the non-mag 
housing, as shown in the figure below. 

 

10-Foot (3-m) Measurement for Calibration Procedure 

Verify that the signal strength at this distance is 660 to 680. Return to the main menu screen (toggle down 
once). Select the calibration option from the main menu screen and click the trigger. Select 1-point 
calibration and follow the prompts to complete the calibration. Do not move the receiver while it is 
calibrating.  

When calibration is complete, the confirmation signal will sound and a checkmark will display on the 
screen, indicating a successful calibration. The screen will then return to the locate mode display. Take 
depth readings at several locations using a tape measure to verify that the depth reading on the display 
remains accurate.  

14.  Measure SST Transmitter Current Draw in Housing 

Using an amp meter hooked up in series, as shown in the figure in step 7 entitled “Setup for SST 
Transmitter Power Up and Amp Reading,” measure the current draw of the SST transmitter—a good 
reading is approximately 0.2 to 0.5 amp. 

15.  Verify Pitch Readings Using Digital Level 

Compare the SST transmitter’s pitch readings at the remote display and the receiver with those shown on 
a digital level. Position the digital level on the housing, and then lift or lower the housing to different 
inclinations and compare the readings on the level against the pitch readings on the remote and the 
receiver to confirm accuracy. 

10 ft (3 m) F5 SST 

receiver 

SST transmitter 
centerline 

SST 
transmitter 
(inside  
non-mag 
housing) 

Outside edge 
of receiver 
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16.  Connect SST Equipment to the Drill 

You are now ready to connect the 10-gauge white wire from the SST transmitter to the monel’s 10-gauge 
wire with a butt splice and heat shrink. The monel is a non-mag drill pipe that measures approximately 15 
ft (4.6 m) in length and must be used between the non-mag housing and the regular drill pipe. Once this 
wire connection is made, the housing can be threaded onto the monel while carefully pulling the slack in 
the wire to ensure that the wire does not get caught in the threads. You will continue to thread the wireline 
through the drill rods in the same manner, carefully making the connection for each drill pipe. 

The following diagram shows how the SST system components are connected. A ground wire needs to 
be installed between the negative terminal of the free-standing battery and a ground point on the drill rig. 
The ground point can be the negative terminal on the drill rig’s battery or a metal contact point on the drill 
rig or drill stem.  

 

Connecting SST System Components 

The compression fitting shown in the diagram is a non-DCI part required to seal the transmitter from the 
drilling fluid. Contact a drill or tooling manufacturer for information on compression fittings. 

With the SST transmitter properly grounded through the drill housing, connect the wire from the trans-
mitter and now exiting the drill string to the power post on the cable box. Rotate the knob on the power 
post counterclockwise until the hole in the post is exposed. Insert the stripped portion of the wire into the 
hole and gently tighten the knob. 

Connect the cable box to the serial port on the laptop computer using the serial cable provided with the 
system. The laptop can be positioned as far as 50 ft (15 m) from the drill.  

SST  
transmitter 

End plug  

Non-mag 
housing Monel Drill rods 

Battery  
(12–28V) 

Serial port  
to computer  

10-gauge 
white wire 

Black wire  White wire  

SST remote display  

Power post  

10-gauge 
wire  

Cable  
box 

Housing to transmitter 
base is negative contact 
for grounding  

Compression 
fitting  

Ground 
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17.  Start LWD Program and Confirm System Operation 

Power up the laptop and then start the LWD program (see LWD Software Instructions section). Select 

File | New or click on the new file icon  on the tool bar, and then select the “Steering” option to open a 

new steering file. The Steering Tool Job Information dialog box will appear before the new file opens. 

  

Steering Tool Job Information Dialog Box 

Enter the requested information; this information can be edited at anytime by selecting Edit | Job 

Information or clicking the edit job information icon  . Click on OK to open the new steering tool job 

file in the LWD application.  

Select File | Upload Control… or click on the upload control icon  on the toolbar to open the Steering 

Tool Data Upload Control dialog box shown below.  

 

Steering Tool Data Upload Control Dialog Box (not connected) 

 Reference heading 
entered on remote  

Select to use heading 
recorded at Rod 0  

(in the next step) as 
reference heading  

Uncheck only if a 
surveyed elevation is 
referenced 

Use these fields to 
change the starting 
position of the bore from 
the ground elevation and 
left/right offset from the 

plan view zero 

Typical rod length 
(cannot be 0)  

Connect to 
device button  

Serial port pull-
down options  

Select to open 
help wizard  
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Using the pull-down menu under Serial Port Connection, select Communications Port (COM1), and then 
click on the connect button below to connect to the cable box. Verify that you see live data, as shown in 
the dialog box below. If you do not, then verify the setup and port selection and try again. 

 

Steering Tool Data Upload Control Dialog Box (connected) 

See the Inputting and Editing Drill Data section later in this manual for complete information on using the 
job information and data upload control dialog boxes. 

Select to input and 
record a different 

heading value than 

displayed here 

Rod length to be 
recorded at next 

logged point  

Log button – select to log 
a data point with the data 

shown on this screen 

Pull Back button – select 
to remove the last logged 
data point (pulled back 
rods may be restored 
until a new data point  

is logged) 
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Logging Drill Run 

18.  Log Rod 0 (zero)   

The first logged point should be recorded when the SST transmitter (in its non-mag housing) is positioned 
so that it is ½ in and ½ out of the ground, as shown in the following diagram. 

 

Tooling Position for First Logged Point 

Once the tool is in position, then click on the Log button in the upper right of the Steering Tool Data 
Upload Control dialog box to log a point. This logged point starts the zero reference of the bore.  

If entry is into a pit, measure the difference in depth between the surface of the ground and the center of 
the slots in the housing. Enter this depth value as the “Rel. Elev. At Entry” in the Steering Tool Job 
Information dialog box. 

 

19.  Locate (if possible), Override Data (if necessary),  
       and Continue to Log 

As the tool moves away from the drill, to maintain a straight drill path the heading readings should match 
the reference heading. Based on your steering commands and the tool’s located position (using the 
receiver), you can determine if the heading and pitch are correct or if compensation in the LWD log is 
required. Be sure to wait a few seconds for all readings to stabilize before pressing the Log button. If the 
heading value is incorrect, it can be edited in the Steering Tool Data Upload Control dialog box before 
logging the rod to override the measured value. It can also be edited after logging by using the Edit 
Steering Tool Data Point dialog box described below. See the Inputting and Editing Drill Data section for 
more information. 

Drill head  
entering ground Surface of  

ground or zero 

reference elevation 

Slots in housing 
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20.  Compensate for Differences Between Tool’s Logged  
       Position Data and Tracked Position 

Differences between the computer’s calculated position and the tool’s tracked position can occur if the 
first point was not logged when the SST transmitter was ½ in and ½ out of the ground, such as when 
using a mud motor, or in cases where the heading measured by the SST transmitter has natural 
variations over the bore path, as determined during a pre-bore walkover. In such cases, it may be 
necessary to compensate by changing the pitch reading, heading, or rod length.  

To modify these values, place your mouse on the row of data to be edited in the data points table in the 
main application window, and double-click to open the Edit Steering Tool Data Point dialog box (see 
figure below). Note that, if you make a change to the data, the rod number for that row will show a gray 
rod as opposed to black for an unmodified data point and it will be highlighted on the data chart. 

 

Edit Steering Tool Data Point Dialog Box 

Depth values that are calculated in the LWD software can only be edited by changing these input values.  

To adjust the recorded bore path based on externally measured data, use the confidence points tab in the 
data tables area of the main application window. Topography must be input in order to use confidence 
points. See the Inputting and Editing Drill Data section for more information. 
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21.  Pull Back Rods, Resteer, and Relog 

If it is necessary to pull back and resteer the tool, you will use the control buttons (Pull Back, Restore, and 
Log) under Rod Log Controls in the Steering Tool Data Upload Control dialog box.  

 

Steering Tool Data Upload Control Dialog Box (pull back) 

Every time you click the Pull Back button, you will remove the data for the last logged data point from the 
profile and plan view plots and also from the data points table (see LWD Software Instructions section). If 
you decide to not pull back after you have retreated rods, you can press the Restore button until you are 
back to the original position or where you want to start resteering, and the original data will reappear. 
Once a rod is pulled back it will remain visible on the screen until a new rod that changes the previous 
bore path is logged. 

NOTE: Be careful to be methodical when pulling back and advancing rods so that you do not hit 
the button more times than the number of rods pulled back or advanced.   

 

Restore button –  
available after a rod  
has been pulled back  
and before a new rod  
is logged 
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22.  Save Drill Data Occasionally 

DCI recommends that you save the drill data periodically during the bore. A suggestion is to include the 
name of the project, the horizontal distance from the launch point (“Dist.” column in data points table), and 
the LWD software version in the filename. For example, for a job where Pole Road is the name of the 
project, 880 feet is the x-distance from the launch point, and the LWD software version is 2.04, an 
appropriate filename would be “Pole Road 880 v2.04”.  

23.  Log Last Rod 

The last rod logged is just as important as the first. At the end of the run, with the tool at the exit location, 
you must measure the length of the last rod and input the length in the Rod Length Information area of 
the Steering Tool Data Upload Control dialog box before logging the data point. The last rod 
measurement is the rod length minus the length of drill rod left on the rack. For example, if you measure 
6 ft (1.8 m) from the make-up/break-out clamps to the top of the rod, then you would subtract 6 ft (1.8 m) 
from the rod length. If the rod length is 10 ft (3.0 m), then the last rod measurement will be 4 ft (1.2 m).  

NOTE: If the depth of the last rod is less than 24 in. (61 cm) and you are tracking the SST 
transmitter with the receiver, you must set the height-above-ground (HAG) 
measurement and log the last data point above the ground level for an accurate 
depth reading, or you can record a pitch-only data point. 

 

 
 

Last Rod Measurement 

Press the Log button after modifying the rod length to the last rod measurement value. 

24.  Save Project 

DCI recommends that you save the project at the end of the bore using at least two different names, 
which will provide an extra copy of the data for backup. Then, if you accidentally make changes you don’t 
want, you can still revert to the earlier version of the file. You may even want to save the drill data more 
than two times.   
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Drill 

Top of rod 
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Summary of Basic Operating Procedure 

 Setting Up SST Laptop 

1.  Plot topography, drill plan, and planned deviation. 

 Setting Up Equipment and Site 

2.  Establish bore path reference line and mark bore path. 

3.  Assemble and torque up non-magnetic housing to non-mag tool.  

4.  Align drill to marked bore path. 

5.  Position and align non-mag tooling assembly onto marked bore path. 

6.  Stage SST equipment and power source adjacent to tooling assembly. 

7.  Connect and power up F5 SST equipment. 

8.  Measure SST transmitter current draw. 

9.  Install SST transmitter into aligned non-mag tooling assembly. 

 Setting Reference Heading and Roll Offset  

10.  Set reference heading and shoot the probe. 

11.  Set roll offset on remote display (if needed). 

12.  Set roll offset on receiver (if needed). 

 Calibrating SST Transmitter and Confirming Proper System Operation 

13.  Calibrate SST transmitter to receiver. 

14.  Measure SST transmitter current draw in housing. 

15.  Verify pitch readings using digital level. 

16.  Connect SST equipment to the drill. 
17.  Start LWD program and confirm system operation. 

 Logging Drill Run 

18.  Log Rod 0 (zero). 

19.  Locate (if possible), override data (if necessary), and continue to log. 

20.  Compensate for differences between tool’s logged position data and tracked position. 

21.  Pull back rods, resteer, and relog. 

22.  Save drill data occasionally. 

23.  Log last rod. 

24.  Save project. 
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LWD Software Instructions  

Starting LWD Program and Opening Files 

The LWD (Log-While-Drilling) software, which is preinstalled on the SST laptop computer, is used with the 
F5 SST guidance system. The SST transmitter is referred to as the “steering tool” in the LWD software.  

There are three ways to start the DigiTrak LWD program:  

 Double-click on the LWD icon    on the desktop. 

 Use the Start button and select Start | All Programs | Digital Control, Inc | DigiTrakLWD |  

DigiTrakLWD. 

 From Windows Explorer, double-click on the DigiTrakLWD.exe file in the C:\Program 
Files\DCI\DigiTrakLWD folder, or the folder you have designated for the storage location.  

After you start up the program, use the File | New command on the menu bar or click on the new file icon 

 on the tool bar then select the “Steering” option to open a new steering file. You will be prompted to 

enter values for the rod length and reference heading before continuing. The rod length may be any value 
other than zero; the reference heading may be any value from 0 to 360. If no reference heading is 
entered, the reference heading used in the file will be that recorded at the first data point (Rod 0). Click on 
OK to open a blank steering tool file, as shown below.  

 

LWD Steering Tool Application Window (without data) 

Job 
information 

Data 
tables 

Chart 
area 

Tool bar 

 

Site  
information 

Status bar 

 

Menu bar 
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To open an existing steering file, use the File | Open command (or the file open icon ). You can also 

open a steering file directly from Windows Explorer. The file extension for a steering file is *.st5. When a 
file is opened, the data information fields and charts are filled with data, as shown below.  

 

LWD Steering Tool Application Window (with data) 

The LWD application menus and tool bar icons are described in the following subsection, and the 
different information fields (site information, job information, data tables, and profile and plan view charts) 
are described afterward. 

We recommend that you review the help files in the LWD software for more information. The tool tip 
helper can also be used to understand different parts of the application window and file. Click on the tool 

tip helper icon  on the tool bar and click on a point of interest within the file to open a help window with 

information about the point of interest.  
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Menu and Tool Bars 

Under each menu item on the menu bar (File, Edit, View, Window, and Help) are commands for running 
the LWD program. Many of the commands are similar to those used in other Windows programs and 
have associated icons on the tool bar. The menu commands and associated tool bar icons are 
summarized below. You can also move the cursor over any icon on the screen for a brief description of its 
function. 

File Menu Commands  

New 
 

Opens the New dialog box where you select the job type to be created 
(“Steering” for an SST or steering tool job). Once a selection is made, a new 
blank job screen appears. 

Open… 
 

Allows you to select an existing project to open from a Windows Explorer 
dialog box. 

Save 
 

Saves an open project using the same file name and folder as designated 
previously. 

Save As…  Opens the Save As dialog box to save the open job to a specified file name 
and folder. When a new file has not yet been saved, selecting the save icon 
on the tool bar will open the same screen as the Save As menu command. 
NOTE: DCI recommends saving SST data often and with different names. 

Print…  Opens the Print dialog box where you can select printing options and print the 
job. 

Print 
Preview… 

 Displays the project on the screen as it would appear printed. 

Print Setup  Allows you to select a printer and printer connection as well as the paper size 
and orientation. 

Import   Allows you to import data saved using the Atlas Bore Planner or terrain or drill 
plan data that you have saved as a comma-separated-value (CSV) file.  

Export 
Spreadsheet... 

 Exports a spreadsheet-compatible CSV (*.csv) Unicode text file so you can 
share charts using standard spreadsheet software. 

Upload 
Control… 

 Launches or hides the Steering Tool Data Upload Control dialog box where 
you can link to the cable box and view and record steering tool data.  

File 1, 2…  Opens the specified previously opened file. 

Exit  Exits DigiTrak LWD program. 
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Edit Menu Commands 

Site 
Information… 

 
Opens the Site Information dialog box where you can enter and edit the 
location and contact information that displays in the site information field in the 
upper left corner of the application window. General comments about the job 
may also be entered in the Site Information dialog box. This dialog box can 
also be accessed by double-clicking in the site information field of the 
application window. 

Display 
Units…  

 
Opens the Display Units dialog box where you can select the depth, pitch, 
temperature, and force/pressure units displayed on the charts in the 
application window. The Set Defaults option in this dialog box will force all 
future files that are opened to use the same setting. 

Job 
Information… 

 
Opens the Steering Tool Job Information dialog box where you can edit 
details associated with the steering job such as the average rod length and 
reference heading used during the bore. A reference elevation and offsets for 
the accurate graphing of data may also be entered here. This dialog box 
automatically launches after a new job is created.  

Utilities… 
 

Opens the Utility Flags dialog box where you can add, change, or delete flags 
and data regarding utilities. 

Profile Chart 
Annotations… 

 
Opens the Steering DataLog Profile Annotations dialog box where you can 
make comments and insert drawings to appear on the profile chart. This 
dialog box can also be opened by holding the shift key down and using the 
mouse button to draw a box in the profile chart area. 

Plan Chart 
Annotations… 

 
Opens the Steering DataLog Plan Annotations dialog box where you can 
make comments and insert drawings to appear on the plan view chart. This 
dialog box can also be opened by holding the shift key down and using the 
mouse button to draw a box in the plan view chart area. 

Profile Chart 
Properties… 

 
Opens the Profile Chart Extents and Mode dialog box where you can adjust 
the scaling of the profile chart. 

Plan Chart 
Properties… 

 
Opens the Plan Chart Extents and Mode dialog box where you can adjust the 
scaling of the plan chart. 

 

Some of the icons on the tool bar that are associated with the Edit menu are not available (grayed out) 
because they pertain to other LWD applications, such as the Pressure-Tension and the Drill DataLog 
applications. 

View Menu Commands  

Toolbar  Shows or hides the tool bar. 

Status Bar  Shows or hides the status bar. 

Bluetooth 
Device List… 

 
Shows a list of registered Bluetooth devices. 
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Window Menu Commands 

New Window  Opens the current file in a new window. 

Cascade  Arranges windows in an overlapped fashion. 

Tile  Arranges windows in non-overlapped tiles. 

Arrange Icons  Arranges icons of minimized windows. 

Window 1, 2…  Goes to specified window. 

 

Help Menu Commands 

Help Topics 
 

Offers you an index to topics on which you can get help. 

About 
DigiTrak 
LWD... 

 Displays the version number of the DigiTrak LWD software. 

 

 

Information Fields 

The steering tool application in the LWD software displays information grouped in related fields as 
discussed briefly below. These data fields are site information, job information, data tables, and chart 
area, as identified on the LWD Steering Tool Application Window shown at the start of this section. 
Detailed information on reading and editing the data fields are provided in the software’s help files. Use 
the tool tip helper or view help topics for more information. 

Site Information 

The site information section displays the job location and client information. Visible on the screen are: 

 Site Name and Location – Job name and physical location of site. 
 Client – Name of customer.  
 Phone – Contact phone number. 

All the address and contact information for the job, client, and contractor are listed on the printed 
document (see “Printing and Previewing Project Files” later in this section for more information regarding 
printed job files). 

There are three ways to open the Site Information dialog box where site information can be edited: select 
the Site Information… command in the Edit menu; click on the site information icon on the toolbar; or 
double-click anywhere in the site information field of the application window. 
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Job Information 

The job information section displays statistical information about the job. This information includes: 

 Date – Date the job was started, which is retrieved from the first uploaded data point.  
 Data Points – Number of data points collected.  
 Typical Rod Length – Typical length of the rods being used for the job. This length is taken from 

the Steering Tool Job Information dialog box, and it must be entered to enable the upload. 
 Depth – Measurement units being used for depth (ft or m).   
 Pitch – Measurement units being used for pitch (% or °).  
 Elevation – Elevation of a survey marker near the bore (if used). 
 Entry – Entry position relative to the (0, 0) coordinates on the charts (positive or negative distance 

on the profile view chart and left, L, or right, R, position on the plan view chart). 

This information as well as the plan reference heading and roll offset (if used) are listed on the printed file 
(see “Printing and Previewing Project Files” later in this section for more information regarding printed job 
files).  

The measurement units can be edited from the Display Units… command in the Edit menu or by clicking 
the edit display units icon on the toolbar.  

There are three ways to open the Steering Tool Job Information dialog box, where you can edit the typical 
rod length, reference heading, reference elevation, and relative position at entry: select the Job 
Information… command in the Edit menu; click on the job information icon on the toolbar; or double-click 
anywhere in the job information field of the application window. The job information dialog box also 
automatically launches after a new job is created. 

Data Tables 

Four types of data tables are provided under tabs in this area of the file: data points, topography, drill 
plan, and confidence points. Each type of data table is described below. View help files for additional 
information. 

Data Points 

The data points table displays a list of all the data points in the job and all associated data. The columns 
in the table include: 

 Rod ID – Number and status of the data point. Clicking on the profile or plan view charts will scroll 
the data points table to the selected data point.  

 Length – Rod length recorded at that data point. 
 Bore – Calculated length of the bore up to that data point. 
 Pitch – Pitch value recorded at the specified data point. Units are those displayed in the job 

information field.  
 Roll – Roll value in degrees recorded at the specified data point. 
 Heading – Heading value in degrees recorded at the specified data point.  
 Hdg.Dev. – Calculated deviation from the reference heading in degrees recorded at the specified 

data point. 
 Dist. – Calculated aboveground distance the SST transmitter has traveled from the drill rig up to 

that data point. 
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 Depth – Calculated depth from the topological ground surface to the bore path at that data point. 
If no topography is entered, depth is undefined and this column will indicate “No Topo.” in the 
table. 

 Rel.Dep. – Calculated depth relative to the 0 line of the Y-axis of the profile chart. 
 Course R/L – Calculated distance right, R, or left, L, from the centerline of the plan view chart. 
 Date/Time – Date and time the specified data point was recorded. This information does not show 

on the charts or printed report. 
 Comments – User-entered comments. 

Data points in the list can be edited, inserted, deleted, hidden, or removed from the chart and printed 
report. Only data points that have been manually inserted can be deleted.  

A data point can be edited and commented on in the Edit Steering Tool Data Point dialog box at any time 
by right-clicking on a data point and selecting Edit or by double-clicking on a data point in the list or on the 
chart. Only measured values and comments can be edited. Calculated values are determined based on 
the measurements recorded or input by the user. See the Inputting and Editing Drill Data section for more 
information on recording and editing data points. 

Topography 

The topography table displays a list of all of the topography points used to graph the ground surface 
terrain (green line) in the profile chart and to calculate depths. The columns in the table include: 

 Topo.Pt. – Number of the topography point as it appears left to right on the profile chart.  
 Dist. – Distance from where the tool enters the ground (Rod 0) to the specified topography point. 

Units are those displayed in the job information field for depth. 
 Rel.Elev. – Vertical distance from the origin or the chart to the specified topography point. Units 

are those displayed in the job information field for depth. 

Topography points can be edited, inserted, deleted, or imported into the topography table.  

A topography point can be edited in the Edit Topo Data dialog box by right-clicking on the table and 
selecting Edit or by double-clicking on a topography point in the list or on the chart. See the Inputting and 
Editing Drill Data section for more information on importing, inserting, and editing topography points. 

Drill Plan 

The drill plan table displays a list of all the points used to graph the planned bore path (gray line) on the 
profile and plan view charts. The columns in the table include: 

 Plan Pt. – Number of the drill plan point as it appears left to right on the profile and plan view 
charts.  

 Dist. – Horizontal distance from where the tool enters the ground (Rod 0) to the specified drill plan 
point. Units are those displayed in the job information field for depth. 

 Rel.Dep. – Vertical distance from the origin of the profile chart to the specified drill plan point. 
Units are those displayed in the job information field for depth. 

 Course R/L – Distance right, R, or left, L, from the reference heading line to the specified drill plan 
point on the plan view chart. Units are those displayed in the job information field for depth. 
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Drill plan data points can be edited, inserted, deleted, or imported into the drill plan table.  

A drill plan point can be edited in the Edit Drill Plan Data dialog box by right-clicking on the drill plan point 
and selecting Edit or by double-clicking on the drill plan point in the list or on the chart. See the Inputting 
and Editing Drill Data section for more information on importing, inserting, and editing drill plan points. 

Confidence Points 

The confidence points table displays a list of all the points physically measured during the bore and input 
into the steering tool file by the computer operator. Confidence points are used to override the calculated 
drill path and to force the graphed data to pass through the measured point. The use of confidence points 
requires topography and a drill path for reference. The columns in the table include: 

 Conf.Pt. – Number of the confidence point as it appears left to right on the profile and plan view 
charts.  

 Dist. – Distance from where the tool enters the ground (Rod 0) to the specified confidence point. 
Units are those displayed in the job information field for depth. 

 Depth – Vertical distance from the terrain surface to the specified measured confidence point. 
Units are those displayed in the job information field for depth. 

 Course R/L – Distance right, R, or left, L, from the reference heading line to the specified 
measured confidence point on the plan view chart. Units are those displayed in the job informa-
tion field for depth. 

Confidence points can be edited, inserted, deleted, or imported into the confidence points table.  

A confidence point can be edited in the Steering Confidence Point dialog box by right-clicking on the 
confidence point in the table and selecting Edit or by double-clicking on the confidence point in the table 
or on the chart. See the Inputting and Editing Drill Data section for more information on importing, 
inserting, and editing confidence points. 

Chart Area 

The profile and plan view charts give a graphical representation of the information contained in the data 
tables and can be annotated to provide additional details about the job. The common features of the two 
charts are discussed below. See the help topics in the LWD software for more information. 

 Graphed Points – Data points, drill plan points, terrain (topology) points, and confidence points 
that have been logged or imported and have not been hidden or deleted display in the chart area. 

 Axes – The X and Y axes of each graph are labeled for the type of data contained in the chart. 
The X-axis of each chart shows the horizontal distance from the drill. The Y-axis of each chart 
differs, as discussed below. 

 Cursor Coordinates – When the cursor is placed anywhere in the chart area, the value of the 
coordinates at that position display. If the cursor is placed on a data point, all values recorded at 
that data point will display. 

 Zoom – To zoom into an area of the chart, hold down the control button on your computer then 
click and hold (control-click) on your mouse while you drag the pointer through the area you wish 
to explode. Release the mouse button once the area is selected. To return the chart to its normal 
scaling, control-click anywhere in the chart area. 
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Profile View Chart 

The profile view area shows the bore’s progress in a two-dimensional profile (depth/distance) view. As the 
bore progresses, and more data points are logged, an automatic scaling feature formats the plot area so 
that the entire bore remains viewable. If terrain and/or a drill plan is entered prior to drilling, the chart will 
automatically be scaled to show all available data. See Profile Chart Properties… under the Edit menu 
for information on manual scaling of the chart.   

 

Profile View Chart Area 

The Y-axis of the chart shows the vertical distance (relative depth and relative elevation) from the chart’s 
origin. 

Cursor coordinate details appear when you hover the mouse over the profile view chart, and data point 
details appear when you hover the mouse over a data point in the chart. 

 

Plan View Chart 

The plan view chart is at the same horizontal position as the profile chart, but it is from a bird’s-eye view.  

 

Plan View Chart Area 

The Y-axis of the chart shows the right/left distance value from the heading reference line, where right (R) 
is a negative value and left (L) is a positive value. 

Cursor coordinate details appear when you hover the mouse over the plan view chart, and data point 
details appear when you hover the mouse over a data point in the chart. 

 

 

Cursor coordinate details  

Terrain graph (topology) 

Bore path 

Annotation 
Utility flag 

Data point details  

Bore path Annotation 
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Editing and Annotating Charts 

The profile and plan view charts can be edited and annotated in a number of ways. Shapes and captions 
can be drawn directly on the charts to describe job site conditions and other points of interest using the 
Edit menu chart annotations commands. And the boundaries of the charts can be changed using the Edit 
menu chart properties commands. The help files in the LWD software provide full instructions on all 
editing capabilities. The instructions below are basic to getting started with the chart editing functions. 

Drawing Shapes and Adding Captions 

There are four ways you can access the chart annotations dialog boxes where you can draw shapes and 
enter information to be included on the chart graph and printed report.  

 Select the profile or plan chart annotations command from the Edit menu.  

 Click on the edit profile or plan chart annotations icon on the tool bar.  

 Place the mouse on an existing annotation and double-click to change its properties. NOTE: 
Captions cannot be edited in this manner; only objects. 

 Hold the shift key down and use the mouse to draw a box around the area you would like a shape 
to appear on the chart. The Location area of the dialog box will automatically be filled with the 
coordinates of the box you drew. 

 

Profile Chart Annotation Dialog Box 
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Both the profile and plan chart annotation dialog boxes function in the same way; only the coordinates 
shown in the Location and Caption sections of the dialog boxes will be different. If you open the chart 
annotations dialog box using the Edit menu command or tool bar icon, you will need to enter the 
coordinates of the shape you wish to draw in the Location section of the dialog box. 

Selecting and Editing Shapes 

Select the shape you would like to appear on the chart from the pull-down menu in the Location section of 
the chart annotations dialog box.  

Adjust the line weight and font size in the Line/Font section of the dialog box.  

Select which parts of the shape you would like to appear in the Draw Shape section of the dialog box.  

The color of the different parts of the shape can be adjusted by double-clicking on the ellipses in the Draw 
Shape section of the dialog box. 

Adding and Editing Captions 

Before a caption can be entered, the check box next to “Draw Caption” in the Draw Shape section of the 
chart annotations dialog box must be checked to activate the Caption section of the dialog box. With the 
Caption section active, type the words you would like to appear on the graph in the text box in this 
section. You do not have to draw a shape to add a caption. 

If a shape is drawn, the caption will appear centered in the shape by default.  

To change the location or orientation of where the caption appears, click in the box next to “Top - Left” in 
the Caption section of the dialog box. Enter the coordinates of where you would like the text to begin.  

To change the orientation of the text, type the value of the slope of the text in the “Text Slope” text box. 

Editing Chart Properties 

To open the profile or plan chart properties dialog boxes where properties such as chart boundaries and 
scaling can be adjusted:  

 Select the profile or plan chart properties command from the Edit menu.  

 Click on the edit profile or plan chart properties icon on the tool bar. 

Automatic scaling is selected by default. Click in the box next to “Auto Scale” to adjust the horizontal or 
vertical scaling and chart boundaries. Then manually enter the coordinates of chart boundaries as you 
would like them to appear. 
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Printing and Previewing Project Files 

To preview the printed pages before you send the file to print, select Print Preview from the File menu or 
click on the print preview icon on the tool bar. To close the print preview window and return to the file, 
click on the Close button in the print preview window. To print the file from the print preview window, click 
on the Print button. 

To edit printing properties such as the printer or paper size and orientation, select Print Setup from the 
File menu or click on the print setup icon on the tool bar. 

There are three ways to print the job data: select Print from the File menu, click on the print icon on the 
toolbar, or click on the Print button in the print preview window. After selecting a print option, the Print 
dialog box will appear. Make any adjustments needed in the Print dialog box, then click on OK. If you 
have the Adobe Acrobat PDF writer software, you can select the Adobe PDF printer to print to a PDF file 
(see your Adobe software documentation).  

The job data will print on at least three pages. The job information, including location, client, and 
contractor information, if entered, will appear on the first page, along with the statistical data about the job 
and any job comments. The profile and plan view charts will appear on the second page. The third page 
(and more if needed) will list the drill data. Data for data points that have been removed will not display. 
The topography survey data and drill data, if entered, will display. 

 

Saving Project Files  

To save an open project file, select Save from the File menu or click on the save icon on the toolbar. If 
the file has already been named and saved, it will automatically be saved under its current file name and 
location. If the project has not yet been saved and named, then the Save As dialog box will open where 
you can enter the file name and select the save location. The default file name is Steering#.st5, where “#” 
represents a number that starts at 1 and advances automatically as files are saved. 

To save an open file with a different file name or location, select Save As from the File menu. The Save 
As dialog box will appear, which automatically opens to the folder where the current file is saved. Change 
the file name and location as desired, then click the Save button. The open file will now have the new file 
name and/or location.  

DCI recommends saving each job file with two different names in the event that one file becomes 
corrupted.  
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E-mailing Report to Customer Who Does  
Not Have DigiTrak LWD software 

The DigiTrak LWD software is able to generate a printed report or an electronic copy of your file, as 
discussed above under “Printing and Previewing Project Files.” In addition, electronic project files can be 
sent to and opened by anyone who has the DigiTrak LWD software. 

If you want to send an electronic copy to a customer who does not have the LWD software, we suggest 
you use a document-generating printer driver to create a PDF file using any of the following: 

 PrimoPDF – This free software is available for download online at www.primopdf.com. With this 
software installed, you can print the report to PrimoPDF instead of your printer and save the 
report as a PDF file. This file can then be attached to an e-mail message. Please refer to 
PrimoPDF for instructions in the use of this product.  

 Bullzip PDF Printer – This free software is available for download online at www.bullzip.com. With 
this software installed, you can print the report to Bullzip PDF Printer and save the report as a 
PDF file. This file can then be attached to an e-mail message. Please refer to Bullzip for 
instructions in the use of this product.  

 Microsoft XPS Printer – Microsoft has generated a nonstandard encapsulated postscript format 
called *.xps. It is a standard Windows component and will probably appear in your printer list. 
Only Microsoft Internet Explorer can present this document type without a translator. If IE is not 
your default web browser, then you or your customer may not be able to view this file type. 
Please refer to http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-
Document-Writer for instructions on use with your specific operating system.  

Additional information can be found at the website: help.digitrak.com  

Once you have a document writer installed: 

1. From the File menu or the toolbar, select the print option to open the Print dialog box. 
2. Under Printer at the top, use the pull-down menu to select your PDF writer or Microsoft XPS 

Document Writer. 
3. Click on the Properties button to open the properties dialog box, and then select portrait or 

landscape orientation (landscape is recommended).  
4. Click on OK to save the orientation and close the properties dialog box.  
5. Click on OK to save the file as a *.pdf or *.xps file type. The Save As dialog box will appear. 
6. Input the name for your file in the file name text box.  
7. Choose the location/folder where you want to save the file.  
8. Click on OK to save the file.  
9. Attach the saved PDF or XPS file to your e-mail message. The customer can view the file in a 

PDF compatible viewer such as Adobe Acrobat or a Microsoft XPS compatible viewer such as 
Internet Explorer.  

As an alternative to e-mailing a PDF or XPS file, the printed document can be scanned and attached to 
an e-mail message. 
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Inputting and Editing Drill Data 

You can manually edit SST project files by plotting the topography (topo) and the planned bore (drill plan) 
into the LWD software before, during, or after a bore. You can also import this information from a 
Microsoft Excel file, but it must be done prior to logging the SST bore.  

Topography 

Topography data points that represent the horizontal distance from the drill rig and the relative elevation 
can be inserted, edited, imported, or removed from the topography table as described below. The 
topography data, or terrain graph, is shown as a green line on the profile view chart.  

Inserting Topography Data Points 

To insert the first or next sequential topography point: 

1. Right-click in any blank cell in the topography table, and then select Insert. A new topo point will 
display in the data table and on the chart with default values for distance and relative elevation. 

2. Edit the topography data values, if necessary. 

To add a topography point to the middle of the list:  

1. Select the topo point prior to where the new point is to be inserted (you can click on the topo point 
in the data list or on the terrain graph). 

2. Right-click on the highlighted point in the list, and then select Insert. A new topo point will display 
in the data table and on the chart with default values for distance and relative elevation. 

3. Edit the topography data values, if necessary. 

Editing Topography Data Points 

To edit an existing topography point: 

1. Select the topo point to be edited (click on the topo point in the data list or on the terrain graph). 
2. Right-click on the highlighted point in the data list and select Edit or double-click on the point in 

the list or on the terrain graph to open the Edit Topo Data dialog box. 

 

Edit Topo Data Dialog Box 
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3. Modify the data as desired in the dialog box. If you select the “Topo Gap” check box, the relative 
elevation will be disabled, and a gap will appear in the green terrain line on the profile view chart. 

4. Click on OK to save your changes or Cancel to close without saving. 

Deleting Topography Data Points 

To delete a topography data point from the list and chart: 

1. Select the topo point to be deleted (click on the topo point in the data list or on the terrain graph). 
2. Right-click on the highlighted point in the list and select Delete. The topo point will be deleted and 

the graph will adjust to connect the data points before and after the one that was deleted. 

Importing Topography Data Points 

You must have a comma-separated-value (CSV) data file of the appropriate format to use the import 
function in the topography data table. 

To create a CSV file of the appropriate format: 

1. Open a spreadsheet program such as Excel. 
2. Skip or enter notes and column headings on the first two rows. They will be ignored when the 

data is imported. 
3. Beginning on the third row of the spreadsheet, enter two columns of data:  

 Column A – List the horizontal distance that each topo data point is from the drill rig in order 
from the closest to the farthest.  

 Column B – List the associated relative elevation (vertical distance from the surface of the 
ground at the drill rig) for each topo data point listed in column A. If no elevation data is 
entered for a data point, there will be a gap in the terrain graph for that distance. 

4. Save the spreadsheet file in its standard format so that it can be found later. 
5. Save the spreadsheet file again in the same location using the File | Save As command to save it 

as a CSV (*.csv) file type, which is available as a pull-down option in most spreadsheet software. 
In some cases, you may have to change the file extension to *.csv. Some features of the original 
spreadsheet may be lost when saving as this file type. The information required for importing the 
terrain data into the LWD software should be retained.  

6. Close the CSV file. 

To import a CSV file into the topography data table: 

1. Right-click anywhere in the topography data table and select Import, or select the File | Import 
command and click on Terrain Survey Data… A Windows Explorer dialog box will display. 

2. Locate and select the CSV file previously saved and click on Open. The topography data table 
will populate and the profile view chart will show the green terrain graph. 
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Drill Plan 

Drill plan data points include the horizontal distance from the drill rig, the relative depth, and the planned 
right/left course deviation. These drill plan points (Plan Pt.) can be inserted, edited, imported, or removed 
from the drill plan table as described below. The drill plan graph, which is the planned bore with the 
measured terrain, appears as shown below. 

 

Drill Plan with Terrain 

Inserting Drill Plan Data Points 

To insert the first or next sequential drill plan point on the table: 

1. Right-click in any blank cell in the drill plan data table and select Insert. A new plan point will 
display in the data table and on the chart with default depth, relative elevation, and course 
deviation values. 

2. Edit the drill plan data values, if necessary. 

Drill plan graph 

Terrain graph 
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To add a drill plan point to the middle of the list:  

1. Select the plan point prior to where the new point is to be inserted (click on the plan point in the 
data list or on the drill plan graph). 

2. Right-click on the highlighted point in the list and select Insert. A new plan point will display in the 
data table and on the chart with default depth, relative elevation, and course deviation values. 

3. Edit the drill plan data values, if necessary. 

Editing Drill Plan Data Points 

To edit an existing drill plan point: 

1. Select the plan point to be edited (click on the plan point in the data list or on the drill plan graph). 
2. Right-click on the highlighted point in the data list and select Edit or double-click on the plan point 

in the list or on the drill plan graph to open the Edit Drill Plan Data dialog box. 

 

Edit Drill Plan Data Dialog Box 

3. Modify the data as desired in the dialog box.  
4. Click on OK to save your changes or Cancel to close without saving. 

Deleting Drill Plan Data Points 

To delete a drill plan data point from the list and chart: 

1. Select the plan point to be removed (click on the plan point in the data list or on the drill plan 
graph). 

2. Right-click on the highlighted point in the list and select Delete. The plan point will be deleted and 
the graph will adjust to connect the data points before and after the one that was deleted. 
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Importing Drill Plan Data Points 

You must have a comma separated value (CSV) data file of the appropriate format to use the import 
function in the topography data table. 

To create a CSV file of the appropriate format: 

1. Open a spreadsheet program such as Excel. 
2. Skip or enter notes and column headings on the first two rows. They will be ignored when the 

data is imported. 
3. Beginning on the third row of the spreadsheet, enter three columns of data:  

 Column A – List the horizontal distance that each drill plan data point is from the drill rig in 
order from the closest to the farthest.  

 Column B – List the associated relative depth (vertical distance from the surface of the 
ground at the drill rig) for each plan point listed in column A. If no depth data is entered for a 
plan point, there will be a gap in the drill plan profile graph for that distance. 

 Column C – List the associated planned course deviation (right/left distance from the 
reference heading line) for each plan point listed in column A. If no depth data is entered for a 
plan point, there will be a gap in the drill plan view graph for that distance. 

4. Save the spreadsheet file in its standard format so that it can be found later. 
5. Save the spreadsheet file again in the same location using the File | Save As command to save it 

as a CSV (*.csv) file type, which is available as a pull-down option in most spreadsheet software. 
In some cases, you may have to change the file extension to *.csv. Some features of the original 
spreadsheet may be lost when saving as this file type. The information required for importing the 
terrain data into the LWD software should be retained.  

6. Close the CSV file. 

To import a CSV file into the drill plan data table: 

1. Right-click anywhere in the drill plan data table and select Import, or select the File | Import 
command and click on Drill Plan Data… A Windows Explorer dialog box will display. 

2. Locate and select the CSV file previously saved and click on Open. The drill plan data table will 
populate, and the profile and plan view charts will populate with all entered data including the 
gray line representing the drill plan graph. 
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Confidence Points 

Confidence data points can only be entered if there is terrain data and there is a drill path (drill data 
points). Confidence data points include the horizontal distance from the drill rig, the relative depth, and 
the planned course deviation (right/left). A confidence point can be inserted, edited, imported, or removed 
from the drill plan table as described below. Only one confidence point can be entered per drill data point 
(or per drill rod). 

To insert a new confidence point:  

1. Place your mouse on the chart area where you would like the confidence point to display, and 
then hold down the control and shift buttons and click the mouse (control-shift-click). The Steering 
Confidence Point dialog box will display. 

  

Steering Confidence Point Dialog Box 

2. Enter the requested information and click on OK. The confidence point will appear on the graph 
as a highlighted point and display in the confidence points data table. The confidence point data 
will override the calculated drill path and force it to pass through the measured point.  

To edit an existing confidence point: 

1. Right-click on the confidence point in the data table and select Edit or double-click on the 
confidence point in the graph to open the Steering Confidence Point dialog box. 

2. Enter the requested information and click on OK. 

To delete a confidence point: 

1. Select the confidence point to be deleted (click on the confidence point in the data table or on the 
confidence point in the graph). 

2. Right-click on the highlighted point and select Delete. The confidence point will be deleted from 
the graph and data table. The graph will display the original calculated value for depth. 

 

Depth value is 
actual depth 

measured with 
respect to terrain  

Distance left (L) or 
right (R) of the 
entry point to 
where confidence 
point is measured  

X Distance is the 
lateral distance from 
the entry point to 
where the confidence 

point is measured  
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Job Information 

The Steering Tool Job Information dialog box allows you to edit such fixed data as the typical rod length, 
the reference heading, the reference elevation, and the relative position of the tool at entry. There are 
three ways to open the Steering Tool Job Information dialog box: 

 Select the Job Information… command in the Edit menu. 
 Click on the job information icon on the toolbar.  
 Double-click anywhere in the job information field of the application window.  

The Steering Tool Job Information dialog box also automatically launches after a new job is created. 

 

Steering Tool Job Information Dialog Box 

You must enter a typical rod length (cannot be 0) in the Rod Length Information field. The rod length units 
may be feet (ft) or meters (m) and can be changed in the Edit | Display Units menu. 

In the Reference Heading area, enter the same reference heading value (unit in degrees) that you have 
set in the remote display (it can be 0). To use the heading recorded at Rod 0 as the reference heading, 
check the box next to “Use Rod 0 Ref. Hdg.”   

In the Survey Point Elevation Change area of the dialog box, the elevation units may be feet (ft) or meters 
(m) and can be changed and can be changed in the Edit | Display Units menu. Check the box next to 
“Do Not Use Reference Elevation” if the bore is not to be mapped in reference to a surveyed elevation 
marker near the bore. This value will appear in the profile chart title line. 

If the drill enters the ground at some elevation other than the ground topography at the start of a bore, in 
a pit for example, then enter the depth deviation from the ground (the 0 reference line of the profile view 
of the bore) next to “Rel. Elev. At Entry” (-2 in the example above). 

If the drill enters the ground at some distance left, L, or right, R, of where the reference heading was set, 
enter the lateral distance of the offset next to “Lat. Offset At Entry” (5 R in the example above). 
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Upload Control  

The Steering Tool Data Upload Control dialog box is used to view and record live data. You can log rods 
(data points), edit the logged rod length and heading, pull back recorded rods, and restore pulled back 
rods, as well as view measurement data and deviation from the plan if a drill plan is used. There are two 
ways to open the Steering Tool Data Upload Control dialog box: 

 Select the Upload Control… command in the File menu.  
 Click on the upload control icon on the toolbar.  

 

Steering Tool Data Upload Control Dialog Box 

Once the upload control dialog box is opened, you can hide it so that you can more easily access these 
controls on the main application screen by clicking on the upload control icon on the toolbar. Click on it 
again or select Upload Control… from the File menu to again display the dialog box. 

Length of drill 
pipe bored since 

last point logged. 
Enter a value here 

if different than 
typical.  
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In the Rod Length Information area, the Typ Rod Len is the typical rod length defined in the Steering Tool 
Job Information dialog box; it cannot be edited here.   

In the Length textbox, you can input the next recorded data point and record it for the next logged rod, if it 
will be different than the typical rod length. NOTE: If a partial rod length is used, this field will 
automatically be filled with the length remaining to finish the whole rod based on the typical rod length. 
For example, the above length input was 4, so the next data point will show 3 for this value to finish the 7 
ft typical rod length. 

Click on the check box next to “Heading” to enter a heading value (in degrees) for the next recorded data 
point and to override the measured heading. NOTE: This manual override of the heading value is used 
when the magnetometer does not provide a valid heading due to metallic objects around the transmitter.  

Under the Heading field, the value is the tool’s measured heading (in degrees); Ref.Hdg is the reference 
heading input in the Steering Tool Job Information dialog box; and Off Hdg is the difference between the 
measured value and reference value of the heading. Off Hdg is negative when the offset is pointing to the 
left of the reference heading as indicated in the upload control dialog box. 
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Steering Tool Data Points 

Steering tool data points appearing in the data points table can be edited, inserted, removed, or hidden 
using the right-click function. A data point that is edited will force surrounding data to be recalculated. A 
data point that is inserted will appear in the data table and on the graph with default values calculated 
according to surrounding data. A data point that is removed will remove the data from the drill path 
calculation and graph. A data point that is hidden will remove the data point from the graph but the 
information contained in the data point will continue to be used for drill path calculations.  

Editing Steering Tool Data Points 

To edit the pitch, heading, and rod length information recorded at a data point: 

1. Open the Edit Steering Tool Data Point dialog box by double-clicking on the data point to be 
edited in the data point table or on the graph or right-clicking on the data point in the table and 
selecting Edit. 

 

Edit Steering Tool Data Point Dialog Box 

2. Modify the data as required. 
3. Click on OK to save changes or Cancel to close without saving. 

Inserting Steering Tool Data Points 

To insert a steering tool data point: 

1. Right-click on the data point prior to where the new data point is to be inserted.  
2. Select Insert. A new data point (Rod ID) will display in the data table and on the chart with default 

calculated values. The inserted data point will be denoted with an “I” in the table to indicate it is 
inserted rather than recorded. 

3. Edit the data values, if necessary. 
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Removing Steering Tool Data Points 

To remove a steering data point from the table and chart calculations: 

1. Right-click on the data point to be removed. 
2. Select Remove. The data point will be removed from the graph and none of its data will be used 

for calculating the drill path. The point will show as removed in the table. 

To restore a removed data point: 

1. Right-click on the data point to be restored.  
2. Select the checkmark next to “Remove” to uncheck the remove option and restore the data point. 

Hiding Steering Tool Data Points 

To hide a steering data point from appearing on the graph: 

1. Right-click on the data point to be hidden. 
2. Select Hide. The data point will be removed from the graph, but its data will still be used for 

calculating the drill path. The point will show as hidden in the table as indicated by the grayed out 
rod next to the Rod ID. 

To restore a hidden data point: 

1. Right-click on the data point to be restored.  
2. Select the checkmark next to “Hide” to uncheck the hide option and restore the data point. 
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Appendix A: 
System Specifications and 
Maintenance Requirements  

The power requirements and environmental requirements for the DigiTrak F5 SST system components 
are listed below. General maintenance requirements for the SST transmitter and the multi-function cable 
box (MFCB) are provided on the following page. 

Power Requirements 

Device (Model Number) Operational Voltage Operational Current 

DigiTrak SST Transmitter (SST) 9–28 V  6 A max 

DigiTrak F5 SST Receiver (F5R) 14.4 V  350 mA max 

DigiTrak F Series Remote Display (FSD) 12–28 V   3.2 W max 

DigiTrak MFD Remote Display (MFD) 12–28 V   3.2 W max 

DigiTrak Multi-Function Cable Box (MFCB) 12–28 V  6 A max 

 

Environmental Requirements 

Device Relative Humidity Operating Temperature 
System Working 

Altitude 

DigiTrak SST Transmitter <100% -4 to 131° F (-20 to 55° C) 

Up to 6561 ft. 
(2000 m) 

DigiTrak F5 SST Receiver <90% -4 to 140° F (-20 to 60° C) 

DigiTrak FSD Remote <90% -4 to 140 °F (-20 to 60° C) 

DigiTrak MFD Remote  <90% -4 to 140° F (-20 to 60° C) 

DigiTrak Multi-Function 
Cable Box 

<90% -4 to 140° F (-20 to 60° C) 
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General SST Transmitter Care Instructions  

Do not pull on the transmitter’s cable. A cable transmitter extraction/insertion tool, which is essentially a 
threaded metal rod, is provided with the transmitter and is available through any authorized DigiTrak 
dealer. It is used for inserting and extracting the cable transmitter into or out of the housing. Two threaded 
holes (1/4”-20 thread) are provided at the back of the cable transmitter for threading the extraction tool.   

If the cable wire becomes exposed at the base of the transmitter, the cable should be trimmed and 
reinstalled or replaced.  

Instructions and parts for replacing the cable are provided in the Replaceable Wire Kit (DCKIT) sent with 
the cable system and available through any authorized DigiTrak dealer.  

The SST transmitter must be kept at least 5 ft (1.5 m) away from all magnets including the remote display, 
which has a magnetic mount that will damage the transmitter. A protective magnetic shield is provided 
with the SST transmitter and is available through any authorized DigiTrak dealer. The magnetic shield 
should be placed on the end of the SST transmitter at all times when the transmitter is not in use.  

Placing tape around the fiberglass tube of the transmitter, if space allows, will keep the fiberglass 
protected from most corrosive environmental wear.   

Send in the Product Registration Card for the 90-day Limited Warranty.   
 

General Cable Box Care Instructions  

Do not disassemble. The cable box contains no user-serviceable parts.  

Clean exterior with a damp cloth.  

Do not submerge.  

Do not pressure wash.   

Ensure all ports remain clean and clear of debris. Pressurized air or a soft brush may be used to remove 
debris from the cable ports.  

A wire brush may be used to clean the power post.  

Send in the Product Registration Card for the 1-year Limited Warranty.  
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General Equipment Maintenance 

Turn off all equipment when not in use.  

Store the equipment in cases, away from heat, cold, and moisture. Test to confirm proper operation prior 
to use. 

Clean the screens on the receiver and remote display using a damp soft cloth without chemicals or 
cleaning agents. 

Clean the receiver, remote, and battery charger case using only a soft moist cloth and mild detergent. 

Do not use chemicals to clean the transmitter. 

Inspect the equipment daily and contact DCI if you see any damage or problems. Do not disassemble or 
attempt to repair the equipment. 

Do not store or ship this equipment with batteries inside. Always remove the batteries from the equipment 
before shipping or periods of non-use. 
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Appendix B: 
Transmitter Wire Repair 

or Replacement 

You will need to replace the cable lead and other end cap components in the cable transmitter when the 
wire shows wear, twists, or abrasions. This involves removing the transmitter end cap to access the cable 
lead connection to the transmitter base. The Replaceable Wire Kit (DCKIT) includes enough parts to 
replace the cable lead two times. You will also need a standard screw driver. 

The DCKIT contains: 

 Two cable leads 
 Four Torx screws 
 Four lock washers  
 Four 2-021 O-rings 
 Two screw insulators 
 Two 2-106 O-rings 
 Two brass set screws 
 Three white nylon set screws 
 One T15 Torx wrench  
 One each 5/64”, 1/8”, and 3/32” Allen wrenches 
 One tube of Noalox anti-oxidant compound 

 

Wireline End of Cable Transmitter 

 

To disassemble and reassemble the transmitter end cap: 

1. Using the 5/64” Allen wrench or the T15 Torx wrench, depending on the screw type installed, remove 
the two Torx or buttonhead cap screws and lock washers. 

2. Pull the end cap from the transmitter base. 

3. Identify the deepest set screw depression in the base. Using the 1/8” Allen wrench or a standard 
screw driver, remove the white nylon set screw. There will be a brass set screw behind the nylon 
screw that holds the cable in place. NOTE: Do not tamper with the brass set screw and O-ring located 
on the opposite side of the base in the shallow depression. 

4. Using the 3/32” Allen wrench, remove the brass set screw inside the transmitter base that holds the 
cable lead to the base. 

5. Remove the old wire, the 2-106 O-ring, and the screw insulator. Removing the old wire from the base 
may require some force. 

6. Install a new insulator and 2-106 O-ring onto a new cable lead, and insert the wire in the base. (Be 
sure that only 5/16” of the wire coating is stripped back from the end of the tinned cable lead.) 

7. Install a new brass set screw using the 3/32” Allen wrench. Push the cable lead in while tightening the 
set screw to ensure a good connection. 

8. Using the standard screw driver or the 1/8” Allen wrench, install a new white nylon set screw into the 
side of the transmitter base. 

Transmitter 
end cap 

Threaded holes for 
extraction/insertion 

tool (2 places) 
 

Torx or  
buttonhead cap 
screws (2 places) 

Transmitter 
body 
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Exploded View of Cable Transmitter Base and End Cap Assemblies 

9. Install two new 2-021 O-rings. 

10. Coat the top and sides of the base with a thin layer of Noalox to prevent electrical corrosion (do not 
substitute with standard grease). 

11. Replace end cap and line up the screw holes on the base with the nonthreaded holes on the cap. 

12. Install two new lock washers and Torx screws, and tighten the screws in place using the T15 Torx 
wrench.   

 

NOTE:   Use care when threading the Torx screws into the base to avoid cross threading. 
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LIMITED WARRANTY 

Digital Control Incorporated ("DCI") warrants that when shipped from DCI each DCI Product will conform to DCI’s current published 
specifications in existence at the time of shipment and will be free, for the warranty period (“Warranty Period”) described below, from 
defects in materials and workmanship. The limited warranty described herein (“Limited Warranty”) is not transferable, shall extend only to 
the first end-user (“User”) purchasing the DCI Product from either DCI or a dealer expressly authorized by DCI to sell DCI Products 
(“Authorized DCI Dealer”), and is subject to the following terms, conditions and limitations: 

1. A Warranty Period of twelve (12) months shall apply to the following new DCI Products: receivers/locators, remote displays, battery 
chargers and rechargeable batteries, and DataLog

®
 modules and interfaces. A Warranty Period of ninety (90) days shall apply to all 

other new DCI Products, including transmitters, accessories, and software programs and modules. Unless otherwise stated by DCI, 
a Warranty Period of ninety (90) days shall apply to: (a) a used DCI Product sold either by DCI or by an Authorized DCI Dealer who 
has been expressly authorized by DCI to sell such used DCI Product; and (b) services provided by DCI, including testing, servicing, 
and repairing an out-of-warranty DCI Product. The Warranty Period shall begin from the later of: (i) the date of shipment of the DCI 
Product from DCI, or (ii) the date of shipment (or other delivery) of the DCI Product from an Authorized DCI Dealer to User. 

2. DCI’s sole obligation under this Limited Warranty shall be limited to either repairing, replacing, or adjusting, at DCI’s option, a 
covered DCI Product that has been determined by DCI, after reasonable inspection, to be defective during the foregoing Warranty 
Period. All warranty inspections, repairs and adjustments must be performed either by DCI or by a warranty claim service authorized 
in writing by DCI. All warranty claims must include proof of purchase, including proof of purchase date, identifying the DCI Product 
by serial number. 

3. The Limited Warranty shall only be effective if: (i) within fourteen (14) days of receipt of the DCI Product, User mails a fully 
completed Product Registration Card to DCI; (ii) User makes a reasonable inspection upon first receipt of the DCI Product and 
immediately notifies DCI of any apparent defect; and (iii) User complies with all of the Warranty Claim Procedures described below. 

WHAT IS NOT COVERED 

This Limited Warranty excludes all damage, including damage to any DCI Product, due to: failure to follow DCI’s operator’s manual and 
other DCI instructions; abuse; misuse; neglect; accident; fire; flood; Acts of God; improper applications; connection to incorrect line 
voltages and improper power sources; use of incorrect fuses; overheating; contact with high voltages or injurious substances; use of 
batteries or other products or components not manufactured or supplied by DCI; or other events beyond the control of DCI. This Limited 
Warranty does not apply to any equipment not manufactured or supplied by DCI nor, if applicable, to any damage or loss resulting from 
use of any DCI Product outside the designated country of use. By accepting a DCI Product and not returning it for a refund within thirty 
(30) days of purchase, User agrees to the terms of this Limited Warranty, including without limitation the Limitation of Remedies and 
Liability described below, and agrees to carefully evaluate the suitability of the DCI Product for User’s intended use and to thoroughly read 
and strictly follow all instructions supplied by DCI (including any updated DCI Product information which may be obtained at the above DCI 
website). In no event shall this Limited Warranty cover any damage arising during shipment of the DCI Product to or from DCI. 

User agrees that the following will render the above Limited Warranty void: (i) alteration, removal or tampering with any serial number, 
identification, instructional, or sealing labels on the DCI Product, or (ii) any unauthorized disassembly, repair or modification of the DCI 
Product. In no event shall DCI be responsible for the cost of or any damage resulting from any changes, modifications, or repairs to the 
DCI Product not expressly authorized in writing by DCI, and DCI shall not be responsible for the loss of or damage to the DCI Product or 
any other equipment while in the possession of any service agency not authorized by DCI. 

DCI reserves the right to make changes in design and improvements upon DCI Products from time to time, and User understands that DCI 
shall have no obligation to upgrade any previously manufactured DCI Product to include any such changes. 

THE FOREGOING LIMITED WARRANTY IS DCI’S SOLE WARRANTY AND IS MADE IN PLACE OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE, IMPLIED WARRANTY OF NON-INFRINGEMENT, AND ANY IMPLIED WARRANTY ARISING FROM 
COURSE OF PERFORMANCE, COURSE OF DEALING, OR USAGE OF TRADE, ALL OF WHICH ARE HEREBY DISCLAIMED AND 
EXCLUDED. If DCI has substantially complied with the warranty claim procedures described below, such procedures shall constitute 
User’s sole and exclusive remedy for breach of the Limited Warranty. 

http://www.digitrak.com/
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LIMITATION OF REMEDIES AND LIABILITY 

In no event shall DCI or anyone else involved in the creation, production, or delivery of the DCI Product be liable for any 
damages arising out of the use or inability to use the DCI Product, including but not limited to indirect, special, incidental, or 
consequential damages, or for any cover, loss of information, profit, revenue or use, based upon any claim by User for breach of 
warranty, breach of contract, negligence, strict liability, or any other legal theory, even if DCI has been advised of the possibility 
of such damages. In no event shall DCI’s liability exceed the amount User has paid for the DCI Product. To the extent that any 
applicable law does not allow the exclusion or limitation of incidental, consequential or similar damages, the foregoing 
limitations regarding such damages shall not apply. 

This Limited Warranty gives you specific legal rights, and you may also have other rights which vary from state to state. This Limited 
Warranty shall be governed by the laws of the State of Washington. 

WARRANTY CLAIM PROCEDURES 

1. If you are having problems with your DCI Product, you must first contact the Authorized DCI Dealer where it was purchased. If you 
are unable to resolve the problem through your Authorized DCI Dealer, contact DCI’s Customer Service Department in Kent, 
Washington, USA at the above telephone number between 6:00 a.m. and 6:00 p.m. Pacific Time and ask to speak with a customer 
service representative. (The above “800” number is available for use only in the USA and Canada.) Prior to returning any DCI 
Product to DCI for service, you must obtain a Return Merchandise Authorization (RMA) number. Failure to obtain an RMA may 
result in delays or return to you of the DCI Product without repair. 

2. After contacting a DCI customer service representative by telephone, the representative will attempt to assist you in troubleshooting 
while you are using the DCI Product during actual field operations. Please have all related equipment available together with a list of 
all DCI Product serial numbers. It is important that field troubleshooting be conducted because many problems do not result from a 
defective DCI Product, but instead are due to either operational errors or adverse conditions occurring in the User’s drilling 
environment. 

3. If a DCI Product problem is confirmed as a result of field troubleshooting discussions with a DCI customer service representative, 
the representative will issue an RMA number authorizing the return of the DCI Product and will provide shipping directions. You will 
be responsible for all shipping costs, including any insurance. If, after receiving the DCI Product and performing diagnostic testing, 
DCI determines the problem is covered by the Limited Warranty, required repairs and/or adjustments will be made, and a properly 
functioning DCI Product will be promptly shipped to you. If the problem is not covered by the Limited Warranty, you will be informed 
of the reason and be provided an estimate of repair costs. If you authorize DCI to service or repair the DCI Product, the work will be 
promptly performed and the DCI Product will be shipped to you. You will be billed for any costs for testing, repairs and adjustments 
not covered by the Limited Warranty and for shipping costs. In most cases, repairs are accomplished within 1 to 2 weeks. 

4. DCI has a limited supply of loaner equipment available. If loaner equipment is required by you and is available, DCI will attempt to 
ship loaner equipment to you by overnight delivery for your use while your equipment is being serviced by DCI. DCI will make 
reasonable efforts to minimize your downtime on warranty claims, limited by circumstances not within DCI’s control. If DCI provides 
you loaner equipment, your equipment must be received by DCI no later than the second business day after your receipt of loaner 
equipment. You must return the loaner equipment by overnight delivery for receipt by DCI no later than the second business day 
after your receipt of the repaired DCI Product. Any failure to meet these deadlines will result in a rental charge for use of the loaner 
equipment for each extra day the return of the loaner equipment to DCI is delayed. 

 


